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Special Notice 
 
Please see the WHATS NEW section of the README.RTF file included in the PowerHome 
software for the latest information about PowerHome.  
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Introduction 
 
PowerHome is an extremely powerful and flexible Windows based software package that will give 
you full control over your home’s lighting, appliances, and infrared devices when used in 
conjunction with the appropriate control hardware. 
 
With PowerHome’s programmable interface, this control can be achieved via keyboard, mouse, 
web, email, X-10, IR, RS-232, voice recognition, socket communications, Windows Messaging, 
and even your internet enabled cell phone. 
 
It is highly recommend that you take the time to at least briefly review this document 
before attempting to use PowerHome as certain aspects will not be readily apparent. 
 
 

 

(PowerHome Screen with Insteon Explorer opened) 

 
 

 
1.1 Features 
 

 Insteon and X-10 Control via PowerLinc Controller V2 (Serial and USB) 
 Supports all Insteon Devices, auto discovery, software linking, spidering, full KPL 

(Keypad) support 
 Supports Elk M1 Gold (Serial and Ethernet) 
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 Fully programmable interface via your choice of languages.  You can use the internal 
macro and formula scripting or any language supported by Windows Script such as 
VBScript and JScript 

 Internal web server for remote control and monitoring.  Supports user defined dynamic 
content via PSP (PowerHome Server Pages).  Also support for custom web pages via 
plugins 

 Voice recognition 
 Text to speech 
 User definable remote layouts allow for virtually any keystroke combination 
 Touch screen friendly interface 
 Customizable display allows you to show floor plan layouts and place controls over actual 

photos 
 X-10 control via CM11A, CM17A firecracker, MR26A Mouse Remote, CPU-XA/Ocelot, 

W800, W800RF32, PowerLinc RS-232, and Elk M1 Gold  
 Infrared control via CIR, Multi-CIR, RedRat2, RedRat3, CPU-XA/Ocelot, Slink-e, USB-

UIRT, Global Cache.  Also supports multi-zone IR 
 Digital Input/Output, and Analog Input/Output control with the CPU-XA/Ocelot (with 

additional Adicon modules), Elk M1 Gold, Velleman K8000,  Insteon SimpleHomeNet 
devices 

 Unlimited number of controllers supported 
 CD jukebox player control with playlists and auto programming  
 CD database with freedb support  
 Video database  
 Macros  
 Triggers  
 Timed events  
 Full event and web logging  
 Multi-X control allows a sequence of X-10 commands for control (access 256 macros 

from your palm pad by pressing 2 buttons, 64 macros from your keychain remote by 
pressing 3 buttons.)  

 Sunrise, sunset, and civil twilight calculations  
 Socket Server for remote control of PowerHome from other applications and machines 
 Windows Messaging Interface for additional remote control capabilities 
 Windows Script Host Interface 
 Built-in WAP server for remote control via an internet enabled cell phone 
 Full DI/DO and AI/AO support for the Velleman K8000 controller 
 Generic plugin capability and SDK.  Create your own ActiveX plugins to extend and 

enhance PowerHome functionality.  All plugins run in their own thread for maximum 
performance and reliability 

 PowerHome can run as a service 
 UDP Broadcast Server.  Third party programs and applications are capable of monitoring 

PowerHome internals and reacting appropriately 
 

1.2 Technical Overview 
 

 Written in Sybase PowerBuilder version 9.0.2 
 All code and data maintained in Sybase Adaptive Server Anywhere Database system 
 Custom DLL's written in Microsoft Visual C and assembly 
 Voice recognition licensed from Microsoft (SAPI 4.0a) 
 Text to Speech licensed from Microsoft (SAPI 4.0a and SAPI 5) 
 Remote Access Server Dialup control licensed from SocketWrench 
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1.3 System Requirements 
 

 Windows 95/98, Windows NT/2000/XP (CIR device requires Windows 95/98)  
 486 with 16 megs of RAM (Pentium with 32 megs of RAM recommended minimum for 

voice recognition.  Certain operating systems may have operating requirements beyond 
the above minimums)  

 Unused serial port/s (CM11A interface, CM17A firecracker, MR26A Mouse remote, 
RedRat2, CPU-XA/Ocelot, Slink-e, W800, W800RF32, PowerLinc RS-232, USB-UIRT, 
PowerLinc Controller V2 Serial, Elk M1 Gold Serial, Insteon PowerLinc 2414S)  

 Unused parallel port/s (CIR interface, Multi-CIR, Velleman K8000)  
 Unused USB port (RedRat3, USB-UIRT, PowerLinc USB, PowerLinc V2 USB, Insteon 

PowerLinc 2414U) 
 Sound card (text to speech and voice recognition)  
 Network connection (for Web Server and Socket Server access.  Elk M1 Gold Ethernet, 

Global Cache GC-100) 
 Internet connection (for remote Web Access and freedb support)  
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Getting Started 
2.1 Installing PowerHome 
 
PowerHome can be downloaded from http://www.power-home.com and is fully functional with a 
30 day evaluation period.  After the evaluation period has expired, PowerHome will not send 
commands to hardware controllers and will have to be registered.  You may purchase an unlock 
key from the above website. 
  
If you are installing PowerHome for the first time, just run the setup.exe file and follow the 
instructions. If you are upgrading from a previous version, please follow the upgrade instructions 
in the next section.  
 

2.1.1 Upgrading from an Earlier Version 
 
Follow these steps to upgrade from version 1.03.4.7, 1.03.4.8, 1.03.4.9, 1.03.4.10  
 

1. Rename your existing PowerHome installation directory. The default install directory will 
be C:\Program Files\PowerHome. Do not install over your existing directory.  

 
2. Install version 1.03.4.11. Be sure that you do not install to the same directory as your 

existing version.  
 

3. Copy your existing pwrhome.db and pwrhome.ini files from your old PowerHome 
installation to the new PowerHome directory structures. Overwrite the newly installed files 
with your old ones. You may also copy over any other files you've created that are not a 
part of the PowerHome install such as PSP files, Windows Script Host scripts, and 
graphics.  

 
4. Run the PHUPG.EXE PowerHome Database Upgrade Utility. This will upgrade your 

database to version 1.03.9.5 as well as upgrade your pwrhome.ini file with the latest 
required changes.  

 
5. Thats it! You should now be able to launch and run version 1.03.4.11 of PowerHome.  

 
6. Make note of specific changes to functions and deleted functions. These differences are 

noted in the What's New section of the readme.rtf file.  

Upgrading to version 1.03.4.11 from versions prior to 1.03.4.7:  

First upgrade to version 1.03.4.7. After successfully upgrading to version 1.03.4.7, follow the 
instructions above to upgrade to 1.03.4.11 or visit the PowerHome website at http://www.power-
home.com.  The instructions can also be found in the readme.rtf file. 
 
 

2.2 Starting PowerHome the First Time 
 
When starting PowerHome for the first time, you will be asked to enter a registration name.  This 
name must be between 5 and 50 characters and will be used to generate your registration 
number.  This registration number can be found under the menu Help->About.  After the 
registration name has been entered, PowerHome will be running. 
 

http://www.power-home.com
http://www.power-home.com
http://www.power-home.com
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2.3  A Brief Message for Beginners 
 
PowerHome is an extremely flexible and powerful software home automation control package.  
As such, its features and interface may be overwhelming at first.  This QuickStart guide will get 
you up and running quickly with a core set of features.  Absent from this guide will be details of 
programming and formulas.  As you become comfortable with PowerHome, you may gradually 
work into these advanced features for the ultimate in power and functionality.   
 
All features of PowerHome, including the advanced features, can be found in the PowerHome 
Users Manual included with your PowerHome download. 
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Turning On A Light 
 
 

3.1 But, How Do I Turn On A Light? 
 
If you’re like most PowerHome users, you’ve already thought about the many things you want to 
do with PowerHome.  PowerHome can control not only home lighting (X-10 and Insteon) but 
home theaters (through IR and RS232, X-10 and Insteon), blinds and drapes, heating and air 
conditioning systems, security systems (Elk M1 Gold), sprinklers, make voice announcements, 
get the weather through the Web and announce it or show it on your PC, touch screen or web 
enabled phone, announce telephone callers (Caller ID with an appropriate modem) and the list 
goes on.  PowerHome can control your home not only through your PC, but through remote PCs 
throughout your home, touch screens, through the web and email. It can email you home status 
reports, alerts or whatever you choose.  This list is not exhaustive.  Imaginative PowerHome 
users have implemented many additional uses for PowerHome..  An active PowerHome user 
forum, where PowerHome users share ideas, can be found at http://www.power-
home.com/forum/default.asp. 
 
The first thing most new PowerHome users want to know is how to turn on a light.  This part of 
the QuickStart guide will take you through the basic steps to turn an Insteon light switch on and 
off.  The rest of the QuickStart guide will take you on a brief tour of some of PowerHome’s 
features.  Additional instructions and features can be found in the PowerHome Users Manual. 
 

3.2 Checklist For Turning On An Insteon Light 
 

 Install PowerHome (see section 2 above) 
 Let PowerHome know you have an Insteon PowerLinc Controller (see section 3.3) 
 Let PowerHome know you have an Insteon light switch (see section 3.4) 
 Turn on the light using the Device Status Screen (see section 3.5) 
 Or Turn on the light using the Insteon Explorer Screen (see section 3.6) 
 Or Turn on the light using a macro (see section 3.7) 
 Or Turn on the light using a timed event (see section 3.8) 

 

3.3 Let PowerHome Know You Have An Insteon PowerLinc 
Controller 
 
PowerHome interfaces with your home through a variety of hardware controllers connected to 
your PC.  The various controllers supported by PowerHome are capable of sending and receiving 
Insteon and X-10 signals (powerline and RF), IR (infrared) signals, digital inputs / outputs, and 
analog inputs / outputs.  You should have at least one controller connected to PowerHome, but 
you can have multiple controllers connected to PowerHome through your PC.   
 
To set PowerHome up for Insteon use, you must first let PowerHome know that you have an 
Insteon controller connected to your PC.  You do this through the PowerHome Explorer.   
 
If you have not already done so, start PowerHome on your computer. 
 

http://www.power-home.com/forum/default.asp
http://www.power-home.com/forum/default.asp
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(Figure 3.3.1 PowerHome Explorer) 

 
 

 
The PowerHome Explorer can be found under the Maintenance dropdown menu on top of your 
screen (Figure 3.3.1).  You will become very familiar with the PowerHome Explorer window as 
you learn more about PowerHome because this is where you setup many of your devices and 
preferences for PowerHome.  You will return to this window often.  
 

1. Open the PowerHome Explorer and using the left-hand tree view, navigate to 
PowerHome->Setup->Controllers.   

 
2. Assign a short, meaningful ID (you will use this ID to send Insteon commands).  In the 

example below (Figure 3.3.2) the PowerLinc Insteon Controller (PLC) is named MY 
INSTEON CONTROLLER but you can choose a more meaningful name like MYCTRLR 
or INSTPLC 

 
3. Choose the "Insteon DM" controller type.  This tells PowerHome that you’re using an 

Insteon Controller.  There are other types of controllers which are discussed in the 
PowerHome Users Guide. 

 
4. Click the "Active" box.   You can click the "Settings" button to see the individual settings, 

but the defaults should be fine.  
 

5. Restart or reinitialize PowerHome in order for the changes to take effect and allow the 
Insteon Controller to load.  
(To reinitialize PowerHome, left click on the first button on the tool bar.  To restart 
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PowerHome, close PowerHome and then open PowerHome.) 
 

 

(Figure 3.3.2 Setting Up A Controller) 

 
 

Once PowerHome is restarted / reinitialized, the SmartHome Insteon Device Manager (SDM) 
should automatically load.  The SmartHome Insteon Device Manager is not part of PowerHome, 
but is a software program written by SmartHome that is installed along with PowerHome and 
must load on your PC for the Insteon PowerLinc Controller to work.  PowerHome knows this and 
automatically loads the SDM every time PowerHome loads. 
 
Once you reload PowerHome, you should see a new icon in the System Tray (the list of icons on 
the far right of the Start toolbar).  The SDM should automatically detect the type of PowerLinc 
Controller (PLC) and what port it is connected to but sometimes it fails to do so.  If the Device 
Manager is unable to sense your PLC, PowerHome will respond with the message: "The XXX 
PLC is not responding.  Commands will not be sent." where XXX is the ID you assigned to your 
Insteon PowerLinc controller (PLC).  If you should get this message follow the instructions below, 
otherwise skip to the next section. 
 

Open the SmartHome Device Manager by double clicking it's 
icon in the System Tray.  You should see the SmartHome Device 
Manager window open.  Left click anywhere in the big log 
window and then type the letters D M.  A single line edit window 
should open towards the bottom of the screen.  Type "port=?" 
without the quotes in the edit window and press enter.  This 
should force the DM to locate your PLC.  Give it a few seconds 
and you should see "PLC: port=true" in the log window.  
However, if it still cannot locate your PLC, you may get a "PLC: 
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port=false" message.  Whatever message you get, type "getport" 
in the edit window and press enter.  In the log window, you 
should see what port the DM is currently looking at.  If you have 
a USB PLC, then the port should be "USB4".  If your PLC is 
serial, then you should see COM followed by the number of the 
COM port the PLC is on.  If the port returned by getport is not 
correct for your setup then type "port=USB4" if your PLC is USB 
and "port=COM1" if your PLC is serial and connected to COM1.  
Adjust the COM port number for your situation.  You can verify 
the port was set using the "getport" command.  Once the DM 
finally recognizes your PLC, it will store the settings in the 
registry and will be remembered unless you change the port.  
Once everything is communicating, you can minimize the DM. 

 
 

3.4 Let PowerHome Know You Have An Insteon Light Switch 
 
After telling PowerHome that you have an Insteon Controller connected to your PC (section 3.3), 
you have to let PowerHome know that you have an Insteon switch (e.g. a Lamplinc, 
Appliancelinc, Socketlinc, Keypadlinc, etc).which you would like to control through PowerHome.  
As the various types of Insteon switches work similarly for purposes of the examples in this Quick 
Start guide, they’ll be referred to generically, as an Insteon Light Switch.   
 
Open the PowerHome Explorer and using the tree view, navigate to PowerHome->Devices-
>Insteon->Units. (figure 3.4.1)  Using this screen you can manually enter the information about 
your Insteon Light Switch.  Alternatively, PowerHome has the ability to remotely sense your 
Insteon Light Switch and enter most of the necessary information for you.  Auto Discovery of each 
Insteon device is a great feature of PowerHome and is discussed fully in the PowerHome Users 
Manual.  For purposes of this example, you’ll enter the information about your Insteon Light 
Switch manually. 
 

 

(Figure 3.4.1 Setting Up Insteon Devices - Device Detail Screen) 

 
 

1. When you open the Insteon Devices Detail screen you will see a line already populated 
with the information you've already entered in section 3.3.  Since the Insteon Controller is 
an Insteon device and you've already told PowerHome about it, that information is 



 14 

already on this screen.  To open a blank line to enter information about the Insteon Light 
Switch, right click on a blank part of the screen and click Insert.   

 
2. In the ID column enter a name for your Insteon Light Switch. For example, “TEST 

LIGHT.”  You should enter a short, memorable name in the ID column as you will use this 
name often with other aspects of PowerHome. 

 
3. The next column lets your more fully describe the Insteon Device.  Enter whatever you 

like in this column. 
 

4. The third column contains a check box which you should check.  This box determines 
whether PowerHome will attempt communications with the Test Light for link scanning, 
link creating, status polling, etc.  Concepts you will learn more about in the PowerHome 
Users Manual. 

 
5. The fourth column labeled “Address” is quite important.  Each Insteon device has a 

unique address consisting of 3 pairs of hexadecimal characters.  This address is 
generally printed on a label on the front of each Insteon device.  Copy down the address 
from your Insteon Light Switch and type it into this column.  If you’ve previously installed 
your Insteon Light Switch and didn’t copy down it’s address, you can still get its address 
by using the Auto Discovery method discussed in the PowerHome Users Manual. 

 
6. In the “Device Type” column select your Insteon model number from the drop down list. 

 
7. Lastly, type in the location of the Insteon Light Switch.  In this example, “Front Porch” but 

you can type in any location. 
 

8. You can leave the rest of the columns at their defaults. 
 

9. Once you’ve entered the information, it’s important to SAVE it in PowerHome’s database.  
Pressing the F5 key on any screen always saves what you’ve entered on that screen and 
refreshes the displayed data.  It’s a good idea to get into the habit of pressing the F5 after 
you’ve made any entries or changes on any PowerHome screen.  That way, you will be 
sure to have saved your entries. 

 
 

You’re Done!  You’ve just set up PowerHome to turn on your first Insteon Light Switch. 
 
To set up additional Insteon Devices either use the Auto Discovery method found in the 
PowerHome Users Manual or type in information about additional Insteon devices on the Insteon 
Device Detail screen.  To get a blank line on this screen to enter additional Insteon devices, right 
click on a blank portion of the screen and highlight Insert. Then left click on Insert.  A new blank 
line will be created where you can enter information about an additional Insteon device. 
 
Like so many things in PowerHome, there are multiple ways to perform particular tasks.  Instead 
of using the PowerHome Explorer to create our Insteon Light Switch in PowerHome, you could 
have used PowerHome’s Insteon Explorer.  This method is fully discussed in the PowerHome 
Users Manual. 
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3.5 Turn On A Light Using The PH Status Screen 
 
PowerHome gives you many different ways to turn on your Insteon Light Switch.  We are going to 
explore 4 different ways in this QuickStart guide.  You will discover even more in the PowerHome 
Users Manual. 
 
On the PowerHome toolbar, click on the Device Stat button.  The Device Status screen appears 
and all the Devices you’ve previously created appear on the list.  In this example, only the “TEST 
LIGHT” is on the list.   
 
You can now turn the Insteon Light Switch on or off by clicking on the on/off buttons in the Control 
column.   

 

 

(Figure 3.5 Device Status Screen - Turning On A Light) 
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3.6 Or Turn On A Light Using The Insteon Explorer Screen 
 
While the PowerHome Explorer can be used to setup and control Insteon, X-10, IR, etc., the 
Insteon Explorer is a series of screens and tabs dedicated to just Insteon.  From the Insteon 
Explorer Setup tab you can setup the Insteon Powerlinc controller, add an Insteon Light Switch 
through the Device tab (which you’ve already done in section 3.4 using the PowerHome 
Explorer), automatically and manually link Insteon Devices, configure KeypadLincs, view many 
Insteon communication reports, configure the Elk M1 Gold with Insteon information, and view the 
real time commands sent from and to the Insteon Powerlinc controller in the upper windows.  You 
can read more about each of these items in the PowerHome Users Manual. 
 

 

(Figure 3.6.1 Insteon Explorer) 

1. Open the Insteon Explorer and click on the Devices tab.  
 

2. Click on the Control button next to TEST LIGHT Id 
 

3. Click on any of the buttons on the popup control panel and watch your Insteon Light 
Flash, Dim, Brighten etc. (see figure.3.6.2). 
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(Figure 3.6.2 - Popup Control Window on Insteon Explorer Device Tab) 

 

 
3.7 Or Turn On A Light Using A Macro 
 
A macro is simply one or more lines of instructions which tells PowerHome what to do.  From a 
macro you can turn on and off lights, send pre-defined infrared commands, send raw X-10 
commands, call other macros, set variables, launch applications, switch to other applications, 
initiate a web connection, answer a telephone.  Anything that PowerHome can do, can be done 
through a macro.  Read all about the power of macros in the PowerHome Users Manual. 
 
For this example, the macro will turn on the Insteon Light Switch, wait 15 seconds and then turn 
off the Insteon Light Switch. 
 

1. Click on the PowerHome Explorer button (or use the Maintenance dropdown menu to 
open PowerHome Explorer). 

 
2. In the left hand pane click on Macros (or you can click on Macros in the right hand pane). 

 
3. In the right hand pane start filling in the blank row.  Name your macro and type the name 

in the ID column. 
 

4. Describe what your macro will do in the Description column.   
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5. Leave the default entries in the remaining columns. Left click on the left most column 

(looks like a file) to open the macro.  This opens the macro detail screen. 
 

 
 

 
 
  
 
 
 

 
 
 
 
 
 
 

 
 
 

 
 

(Figure 3.7.1 Macro Screen) 

 

 

(Figure 3.7.2 Macro Detail Screen) 

 
 
The TEST MACRO will contain 3 lines. 

 
1. You'll initially only see line 10 on your screen. Use the drop down menus to complete line 

10 as in Figure 3.7.2. 
 
2. Right click on a blank part of the screen and click on insert to create another blank line. 

 
3. The second line is a Wait command which pauses the execution of the macro for the time 

period (in seconds). Type in 15 in the seventh column. Fill in the other columns using the 
drop down menus as in Figure 3.7.2. 
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4. Right click on a blank part of the screen and highlight and click on the Play command. 
The Test Light should turn on, and then turn off after 15 seconds. 

 
5. Make sure to save your new macro by pressing the F5 key. 

 
 

 

3.8 Or Turn On A Light Using A Timed Event 
 
Timed Events are actions that occur within PowerHome based solely upon date and time.  
PowerHome provides a rich set of timed event controls allowing PowerHome to perform actions 
at sunrise, sunset, dawn, dusk, or a specific time.  You can further refine this by declaring the 
frequency of the event to be only weekdays, weekends, everyday, or only a specific day of the 
week.  You can also have this reference time adjusted plus or minus by a specific or random 
amount. 
 
The action taken by PowerHome at the time(s) you specify can be either through a macro or a 
formula.  
 
In this example you’ll run the Test Macro you created in section 3.7 above every hour, 10 minutes 
after our reference time.  The result of this timed event will be that the Test Macro will run at  
12:11, 1:11, 2:11 etc. and continue running once an hour until we close PowerHome, change the 
Timed Event or change the Test Macro. 

 
 

 

(Figure 3.8.1 Timed Events) 

 
1. Click on the PowerHome Explorer button (or use the Maintenance dropdown menu to 

open PowerHome Explorer). 
 

2. In the left hand pane click on Timed Events (or you can click on Timed Events in the right 
hand pane). 

 
3. In the right hand pane start filling in the blank row.  Most of the information can be 

entered using the dropdown menus. 
 

4. The first column is already filled in for you and cannot be changed.  It indicates the first 
date and time this event will be run.  As you fill in the remaining columns this value may 
change. 

 
5. The second column “Timing” lets you indicate whether you want this event to be 

executed at sunrise, sunset, dawn, dusk, or the exact time(s) you choose in the following 
columns.  Choose Exact for this example. 
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6. The ‘Frequency’ column gives you many options.  For this example choose ‘Hourly.’ 

 
7. The ‘Offset’ column lets you randomize or modify by a set amount of time when you want 

the event to occur.  For this example choose ‘Absolute +.’ 
 

8. In the ‘Offset Amount’ column type in 10.  This tells PowerHome that you want this event 
to start 10 Minutes AFTER the reference time.  If you choose ‘Absolute -‘in the previous 
column then the event would have started 10 Minutes BEFORE the reference time. 

 
9. The ‘Reference Time’ column allows you to enter any date and time you wish to start the 

Timed event.  Change this value to today’s date and the present time.  You can then look 
at the first column ‘Start Time’ and see when this Timed Event will occur.  Shown in figure 
3.81 the “Reference Time’ is May 8, 2007 at 12:01 and the start time is May 8, 2007 at 
12:11 when the Test Macro will be triggered.  Note that these 2 columns will reflect the 
day and time you entered and will be different from the above example.    You can 
double-click within this column (or right-click for a pop-up menu) to bring up a calendar 
picker control. 

 
10. In the example above at 12:11 pm on May 8, 2007 the Test Macro will execute and turn 

on the TEST LIGHT, wait 15 seconds, and turn off the TEST LIGHT.  This will occur 
every hour at 11 minutes past the hour.  

 
11. After you’ve verified that your Timed Event is working you might want to delete it or 

change it so that your Test Light will not go on and off every hour. 
 
There are many additional ways to turn on the light in PowerHome.  In addition to the four ways to 
turn on a light described above, you can also use a PowerHome formula, a trigger, and make a 
button to turn the light on or off in the PowerHome Control Center.  These, and several other 
methods, are described fully in the PowerHome Users Manual.  The PowerHome User Manual 
will build upon the techniques you learned through the examples you’ve created above. 
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A Brief Tour- Menus and Toolbars 
 
4.1 Menus 
 
Like many Windows software, PowerHome uses extensive menus and toolbars.  To make things 
easier for the user, there are usually at least two different ways for you to access the function you 
want to perform in PowerHome.  A brief look at each menu and toolbar item follows. 
 

4.1.1  File Menu 
 

 

(Figure 4.1.1 File Menu) 

 
The PowerHome File Menu has the usual Windows printer menu items.  In addition, it indicates 
by way of a check mark, whether a controller is connected to your PC and working with 
PowerHome.  It also allows you to Reinitialize PowerHome for troubleshooting purposes or Exit 
PowerHome completely. 

 
 

4.1.2  Maintenance Menu 
 

 

(Figure 4.1.2  Maintenance Menu) 

 
Most of the configuration and maintenance within PowerHome is accomplished via the 
PowerHome Explorer.  This single window gives you access to the PowerHome database and 
allows you to configure and tailor PowerHome to your liking. (see Figure 3.3.1) 
 
The PowerHome Multi-Editor is an advanced feature.  This screen is a full featured editor for 
several PowerHome supported file formats including SQL, VBScript, HTML, PowerHome 
formulas, etc.  In the case of some formats, you can optionally execute the code (SQL, VBScript, 
Formulas, etc).  Details can be found in the PowerHome Users Manual 
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The Insteon Explorer (see Figure 3.6.1) allows you to configure all of your Insteon Devices in 
many different ways.  You can automatically or manually set up your Insteon devices, as well as 
link them, group them, control them, configure their links, configure Keypad controls in various 
ways, and upload to the Elk M1 security controller.  
 
From the Insteon Explorer you can watch, in real time, which commands are sent to and from 
your PowerLinc controller.  It also has a myriad of Insteon reports allowing you to troubleshoot 
Insteon communication issues. 
 
The Insteon Explorer also allows you to download SmartHome’s Insteon CoreApp and configure 
your PowerLinc controller. (Note:  You cannot download macros or timers from PowerHome to 
the PowerLinc Controller). 
 
Custom Colors, DropDown Sort, Windows Spy are covered in the PowerHome Users Manual. 
 
 

 
4.1.3  Control Menu 
 

 

(Figure 4.1.3 Control Menu) 

 
The Control Center is one of the main interfaces in PowerHome and can be launched 
automatically when PowerHome is started.  This interface consists of user-defined tabs with 
buttons and graphics placed on these tabs.  The tabs, buttons, and backgrounds are fully user 
configurable.  This interface is ideal for touchscreen control and is available in the web interface. 
 
If the Control Center is closed or hidden behind other windows, the hotkey Alt-F1 will always 
open or bring it to the top.  The first 24 tabs are also hot-keyable.  The first 12 are available via F1 
thru F12 and the next 12 are available via Shift-F1 thru Shift-F12.  Buttons on the Control Center 
tabs may be clicked using the mouse or assigned hotkeys. 
 
The Device Status, Palm Pad, PowerHome Status, Web Center, and Timed Events menu 
items each have their own button on the Toolbar and are discussed more fully below. 
 
The Play Playlist and Set Active Playlist menu items are advanced features. Details on each 
can be found in the PowerHome Users Manual 
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4.1.4  Macros Menu 
 

 

(Figure 4.1.4 Macros Menu) 

PowerHome allows you to execute the macros you’ve written in a number of different ways.  The 
Macros Menu is one way.  The Play Macro option has a hotkey of Alt+F2 and will instantly 
transport you from wherever you are to the quick macro player under the menu bar and toolbar.  
You may type a macro ID to play or select one from the dropdown list and press the enter key or 
play button.  You can also use this quick macro player to evaluate formulas.  To do this, you must 
precede the formula with a special character.  Use a single quote ‘ as the very first character of 
the formula to have the formula evaluated without feedback.  Use a double quote “ as the very 
first character of the formula to evaluate the formula with the result appearing in a message box.  
The Set Active Macro option allows you to select a macro in which to record Control Center 
actions.  After selecting a macro from the dropdown window as the current macro, you can right-
click on Control Center buttons and select “Add to Macro” to have the Control Center action 
automatically added as a line in the macro.   
  
In addition to jumping to the quick macro player, the Macros Menu also give you hotkey access to 
up to 48 of your favorite macros.  When you create a macro you have the opportunity to give that 
macro a shortcut key (e.g. Ctrl + F1).  You can view your shortcut keys for the macros you’ve 
created from the Macros 1-12, Macros 13-24, Macros 25-36, Macros 37-48 menu dropdown 
lists. 

 
 
4.1.5  Voice Menu 
 

 

(Figure 4.1.5 Voice Menu) 

 
Text to Speech (TTS) is a powerful feature of PowerHome. You can have PowerHome announce 
the time, weather, telephone callers and that someone is at the door.  The TTS Setup menu 
allows you to set the default PowerHome voice as well as its pitch and speed. 
 
 

4.1.6  Reports Menu 
 
PowerHome currently has six different internal reports that can be viewed from this menu.  
Additional Insteon related reports are available exclusively through the Insteon Explorer. 
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The first report is the Event Log.  This report lists all the activity that has taken place in 
PowerHome and the time the activity occurred.  It is a great report for troubleshooting or just for 
seeing what PowerHome is doing. 
 
The second report, Discs, querys the information entered into PowerHome’s CD database.   
 
The third report, Database Where Used, is for advanced users.  It allows you to search for any 
text string within the database by just typing the text.  For example, to search for all occurrences 
of TEST, just type TEST and search.  This will match any field that exactly matches TEST. 
 
The Insteon menu item opens to list 3 helpful Insteon reports. 
 

 

(Figure 4.1.6 Reports Menu) 

 
 
4.1.7  Window Menu 
 

 

(Figure 4.1.7 Window Menu) 

 
The Window menu is the typical Window’s software menu which allows you to change the 
appearance of PowerHome when various PowerHome screens are opened.  It also allows you to 
delete the toolbar from the screen. 
 
  

4.1.8  Help Menu 
 

 

(Figure 4.1.8 Help Menu) 
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One of the most important screens in PowerHome, the Help menu allows you to access the on 
screen help functions of Powerhome, the PowerHome Homepage on the web, the PowerHome 
Discussion Forum on the web, and Email PowerHome Support. 
 
By clicking About, a screen pops up indicating the version number of PowerHome and the 
database, as well as, your registration number and other useful information. 
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4.2 Toolbar 
 
The Toolbar is an easy way to access many of the features of PowerHome with one click of the 
mouse.  You may click and drag the toolbar to any of the four sides of the screen as well as have 
a floating toolbar.  You can also set the toolbar to use large or small buttons. 

 
 
4.2.1  Reinitialize 
 
Pressing the Reinitalize button on the toolbar allows you to restart PowerHome without closing 
PowerHome and then reopening it.  Certain changes within the PowerHome Explorer require 
PowerHome to be either reinitialized or restarted.  All changes to the Setup section of the 
PowerHome Explorer require Reinitialize or Restart to take effect. 

 

 

(Figure 4.2.1 PowerHome Reinitalizing) 

 
 
4.2.2  Connect 
 
The Connect toolbar button connects or disconnects PowerHome from the Powerlinc Controller 
and all currently loaded controllers.  This is helpful in troubleshooting connectivity issues with the 
PC and any controller.  
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(Figure 4.2.2 Connect Toolbar Button) 

 
 
4.2.3  PowerHome Explorer 
 
Most of the configuration and maintenance within PowerHome is accomplished via the 
PowerHome Explorer.  The PowerHome Explorer is a two-paned window similar in 
functionality and appearance to Windows Explorer.  On the left, is a tree-view navigation panel 
that shows a hierarchical view of the configurable items within PowerHome.  The right-hand pane 
shows the details of the currently selected item.  Typically you will navigate using the left-hand 
pane and make edits and changes in the right-hand pane.  Navigation to children items in the 
right-hand pane can be accomplished by pressing the small button to the far left in each row. (see 
section 3.3.1) 
 

 

(Figure 4.2.3 PowerHome Explorer Toolbar Button) 
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4.2.4  Multi-Edit 
 

 
 
The Multi-Edit button is for advanced users.  Pressing the Multi-Edit toolbar button brings up a 
mini-editor that allows the user to type in and edit a variety of supported PowerHome file formats 
including VBScript, Jscript, HTML, CSS, SQL, and PowerHome Formulas.  For Example, the SQL 
editor allows you to import macros and other exported PowerHome configurables you or others 
have written. 
 
 

4.2.5  Insteon Explorer 
 
The Insteon Explorer (see Figure 3.6.1) allows you to configure all of your Insteon Devices in 
many different ways.  You can automatically or manually set up your Insteon devices, as well as 
link them, group them, control them, configure their links, configure Keypad controls in various 
ways, and download to the Elk M1 security controller.  
 
From the Insteon Explorer you can watch, in real time, which commands are sent to and from 
your PowerLinc controller.  It also has a myriad of Insteon reports allowing you to troubleshoot 
Insteon communication issues. 
 
The Insteon Explorer also allows you to download database information and setup information 
to your PowerLinc controller. (Note:  You cannot download macros or timers from PowerHome to 
the PowerLinc Controller). 

 
 

 

(Figure 4.2.5 Insteon Explorer) 

 
 
4.2.6  Control Center 
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(See section 4.1.3 and section 5.7) 

 
4.2.7  Device Status 
 

 
 
(see section 3.5) 

 
 
4.2.8  Palm Pad 
 
PowerHome includes a virtual Palm Pad X-10 controller.  With this interface you may quickly 
send standard X-10 commands from your computer without having to do any setup (beyond 
telling PowerHome what X-10 controller you have).  The hotkey for opening or bringing this 
interface to the front is Alt-F7. 
 

 

(Figure 4 .2.8 Palm Pad) 
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4.2.9  PH Status 
 
The PowerHome Status screen gives you a real-time peek at what is currently going on within 
PowerHome as well as what has just recently happened.  You can see how long PowerHome has 
been running, how long Windows has been running, and when the next Timed Event is to be 
executed.  You also have access to when sunrise, sunset, dusk, and dawn for your location will 
occur. 
 
You’ll also be able to see what is going on in three of PowerHome’s internal queues.  Things 
happen very quickly in PowerHome so it may appear that the queues are always empty.  You 
should really only see things stack up in the queue when PowerHome is waiting for some process 
to finish. 
 
One of the most useful windows on the PowerHome Status screen is the Event Log.  This 
window shows you in real-time, events in PowerHome as they occur.  This is an extremely handy 
window when attempting to troubleshoot PowerHome. 
 
You can launch the PowerHome Status screen with the hotkey combination Alt-F8.  Each of the 
individual windows may be resized and moved about to create the appearance you find most 
pleasing.  These changes are not automatically saved however and must be saved by right-
clicking and selecting “Save” from the popup menu.  Once your settings have been saved, they 
will be reloaded automatically the next time the window is opened.  You can also control how 
many real time eventlog rows appear at a time by manually adjusting the “eventlogrows” 
parameter in the pwrhome.ini file under the [PowerHome Status] section of that file. 
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(Figure 4.2.9 PowerHome Status) 

 

 
4.2.10 Web Center 
 
 
The Web Center is another PowerHome interface page which can be set as the default load 
page.  The Web Center is basically an Internet Explorer Web Browser window that available for 
remote control from within PowerHome.  You can set the default page to be loaded (typically the 
PowerHome Internal webserver main page or another custom launch page).  Remote control of 
the Web Center window is available using PowerHome formula functions that can be found in the 
Help file.  Control of this window would typically be an advanced user function.  In addition to 
serving up internal PowerHome web pages, the Web Center is a standard browser capable of 
displaying web pages from any Internet site.  One typical use would be to setup a timed event 
within PowerHome to automatically load various pages at different times of the day or based 
upon various PowerHome events. 
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4.2.11 Timed Event 
 

 

(Figure 4.2.11 Timed Event Button) 

 
The Timed Event button is just a toggle button.  It will turn ALL FUTURE timed events either on 
or off.  By default the Timed Event toolbar button is ON. 
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4.2.12 Event Log 
 
The Event Log report shows a complete history of events that have transpired within the 
PowerHome system.  Unlike the Event Log on the status screen, this report is not updated in real 
time.  However, it is not limited to just the last few events and instead shows everything in the 
eventlog table.  You can also sort and filter this report.  Filtering allows you to show only the type 
of information that you’re interested in and hides the rest.  A discussion of filtering can be found in 
the PowerHome Users Manual. 
 

 

 (Figure 4.2.12 Event Log) 
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 Additional Features 
 
This QuickStart Guide is meant to get you up and running PowerHome quickly.  But, there is 
much more to PowerHome.  It all can be reviewed in the PowerHome Users Manual.  Just to 
whet your appetite, here are a few more features of PowerHome, along with a primer on setting 
up PowerHome with X-10 and IR devices. 

 
5.1 What’s a Trigger? 
 
Triggers are fired in response to an internal or external event.  A Timed Event is similar to a 
trigger except that it only responds to date and time.  Triggers have a wider array of responses 
and can be fired when an incoming Insteon,  X-10 or IR signal is received by a controller, when 
an Insteon, X-10 or IR signal is sent by a controller, or when a Windows message or socket 
communications is received. 
 
 

5.1.1  A Trigger Example 
 

1. Triggers like everything else in PowerHome are defined within the PowerHome 
Explorer.   They are located below ‘Timed Events’ in the navigation pane.  Right-click in 
the detail pane and choose ‘Insert’ from the popup menu to create a new trigger. 

 
2. Triggers must have a unique ID.  Type one in the ‘ID’ field.  Type in a description of the 

Trigger in the ‘Description’ field.  For this example use ‘Macro’. in the ‘Action Type 
’box. 

 
3. Choose the macro to execute when the trigger fires in the ‘Action’ dropdown.  You can 

use the Test Macro you created in the section 3.7 example above. 
 

4. The next field determines whether the trigger is ‘Active’ or ‘Disabled’.  Make sure the 
trigger you are creating is active.  Later, you may want to temporarily disable a trigger 
from executing without deleting it. 

 
5. The ‘Trigger Type’ field determines what is going to cause this trigger to fire.  

PowerHome can execute this trigger when it plays an IR command (IR Out), or when a 
supported controller receives an incoming IR command (IR In).  We can do the same with 
Insteon and X-10 commands.   For the purposes of this example, you’ll have the trigger 
fire and the macro run when PowerHome receives an Insteon ON signal from an Insteon 
ControLinc.  If you don’t have an Insteon ControLinc, substitute another device instead.  
Using the dropdown box enter ‘Insteon Group In’. 

 
6. The ‘Trigger ID’ field is a dropdown box which list all of your devices.  Highlight the name 

of your ControLinc (or other Insteon device if you don’t have a ControLinc). 
 

7. The ‘Trigger ID Number’ is another dropdown box which allows you to enter the button 
number or the group number of the Insteon device that is going to trigger the event.  In 
this example, you want button number 1 on the ControLinc to trigger the macro.  Highlight 
1. 

 
8. The ‘Trigger Value’ lets you indicate whether you want the Trigger to execute when you 

press the ControLinc button 1 On or Off.  A Fast On/Fast Off is a quick double tap of the 
button.  The other options are self explanatory.  Enter ON. 
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9. The ‘Boolean’ field is for advanced users.  Leave it at its default value of 1. 
 
Press F5 to save and you’re finished!  Press the first button of your ControLinc ON and the macro 
will run, turning your Test Light On, waiting 15 seconds and then turning OFF the Test Light. 
 

 

(Figure 5.1.1 Test Trigger) 

 
 

5.2 More About Macros 
 

Macros, like everything else in PowerHome, are declared within the PowerHome Explorer 
under ‘Macros’ in the navigation pane.  Right-click in the detail pane and choose ‘Insert’ 
from the popup menu.  Give the Macro a unique ID (short but descriptive to save typing later) 
and a description. (see figure 3.7.1) 

 
The ‘List’ field controls whether the macro appears in the dropdown lists for playing Macros.  
An example is the Quick Macro player just below the toolbar.  If you want this macro to 
appear in the list, be sure that this field is checked.  This list is only updated when 
PowerHome is started or reinitialized. 

 
The ‘Grammar’ field controls whether the macro is used in the Voice recognition grammar for 
Macros.  Voice Recognition is discussed in more detail in the PowerHome User Manual so 
you can leave this field unchecked for now and change it later. 

 
The only other field you may wish to change is the ‘Menu Shortcut’ field.  If you navigate 
PowerHome’s top menu,  ‘Macros’, you’ll find submenus ‘Macros 1-12’, ‘Macros 13-24’, 
‘Macros 25-36’, and ‘Macros 37-48’.  You can make up to 48 macros appear within the 
menu structure along with their appropriate menu hotkeys by setting them in the ‘Menu 
Shortcut’ field.  You would typically only do this for your most often used macros.  When you 
make changes to the ‘Menu Shortcut’ field, the changes are not recognized until 
PowerHome is restarted or reinitialized. 

 
Go to the ‘Macro Detail’ screen by pressing the small button to the left of the macro you wish 
to build. (see figure 3.7.2) 

 
Initially, the ‘Macro Detail’ screen will start with a single blank row. To add additional rows, 
right-click and select ‘Insert’ from the popup menu or press the “tab” key when in the last 
column of the last row. 

 
Macros are a collection of individual macro commands.  Each macro command is contained 
on a single line.  Lines are executed in order starting with the lowest sequence and progress 
up to the highest sequence.  After the last line is executed, the macro terminates.  The first 
column in the Macro Detail table is the sequence.  When you are creating macros, lines start 
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with 10 and each subsequent row is incremented by 10.  This makes it easy to resequence 
the macro lines in a different order.  When you save your macro to the database, this 
sequence will be divided by 10. 

 
The next column in the Macro Detail table is the ‘Skip’ column.  When this column is 
checked, that macro line is not executed.  This feature is useful if you wish to temporarily 
disable some commands from executing without deleting them, as well as, for debugging.  
For now, just be sure that this column is unchecked. 
 
The ‘Type’ field is the type of macro command you would like executed.  If you scroll through 
the dropdown, you will see 43 different macro commands.  A full explanation of all 43 
different macro commands can be found in the PowerHome Users Manual.  A partial list 
follows: 

 
1. IR:    Plays a previously learned IR command. 
2. X-10:    Sends an X-10 command to an X-10 controller. 
3. Macro:   Play another macro. 
4. Launch App:  Launch another Windows application. 
5. Create Timed Event: Create a timed event on the fly. 
6. Jump:   Jump to a different line within the macro. 
7. Delay:   Delay for a specified number of milliseconds. 
8. Wait:   Waits for a specified number of seconds. 
9. Insteon:   Sends an Insteon command to an Insteon controller. 

 
1. The IR command allows you to play a previously learned IR command (see IR Setup 

in section 5.5 below).     In the ‘ID’ column you can select the equipment and in the 
‘Value’ column you can select the actual IR code to play.  The ‘Send Keys / TTS / 
Dim / Formula’ field (hereafter referred to as the ‘SKTTSDF’ field) is not used for IR 
commands.  You can create powerful Home Theater macros using just the IR 
command.  By launching a single macro, you could send the IR commands to turn on 
the TV, the satellite receiver, your amplifier, adjust the volume, and tune to a specific 
channel.  If you threw in a few Insteon or X-10 commands, then you could turn on 
and dim some lights for the perfect lighting mood. 

 
2. The X-10 commands send X-10 commands to an X-10 controller you have previously 

configured PowerHome to use.  This includes Insteon controllers which also send 
and receive X-10 commands. To make maximum use of the X-10 command, it helps 
to understand exactly how X-10 commands work.  The discussion that follows may 
seem a little technical and may be more than you bargained for in a QuickStart 
Manual, but if you take it slow, it’s really not that difficult and will make your 
experience with PowerHome much more enriching.  Here goes:  Most people think of 
X-10 commands consisting of actions such as “Turn a light on”, “Turn a light off”, 
“Dim a light”, and “Brighten a light”.  They also think of these actions as a single 
command.  In actuality, they each consist of two separate X-10 commands.  The first 
X-10 command is called an “address”.  This command talks to a specific 
Housecode/Unitcode and tells it that a “function” command will be coming.  The 
second command is the function command and tells any addressed units to perform 
the specified function.  The format of a standard X-10 command is: 
Housecode/Unitcode or Housecode/Function.  So when we want to turn a light on 
with an X-10 ID of A1, you first send an address command A/1 followed by a function 
command A/On.   
 
PowerHome’s X-10 communication mimics the actual X-10 commands.  After you 
select an X-10 command, select the housecode (A thru P for standard X-10 
commands) in the ‘ID’ field.  Next select a unitcode 1 thru 16 if this is an address 
command or an X-10 function if this is a function command.  Remember, to do 
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something simple such as turn a light on or off will require two X-10 commands on 
two separate macro lines.  First an address command followed by a function 
command.  If you chose a ‘Dim’ or ‘Bright’ command, you can type a value 
dim/bright percentage in the ‘SKTTSDF’ field.  This percentage should be in the 
range of 0 to 100 and is the amount to adjust the light from its current level.  In other 
words, if a light is currently at level 80 and you have a dim value of 50, the light will 
dim 50% bringing its current dim level to 30. 

 
3. The Macro command is easy.  Simply select the ID of another macro you would like 

to play from the dropdown box.  In the ‘Value’ field, select whether to play the macro 
immediately (the current macro is put on hold and the new macro played.  When the 
new macro is done, the current macro is resumed at the next line) or ‘Post’ the 
macro (the new macro will be played after the current macro is completed). 

 
4. With the Launch App command, you can have PowerHome startup another windows 

program.  In the ‘SKTTSDF’ field, type the full path and filename of the program you 
would like to launch.  The full path should be enclosed in either single or double 
quotes. 

 
5. The Create Timed Event command allows you to insert entries into the Timed 

Events Table.  This command is useful when you want a macro to make something 
happen in the future.  You will select a macro ID in the ‘ID’ column and then type a 
value in the ‘SKTTSDF’ field representing a date/time in the future when you want 
that macro to be played.  You can place two different values here.  You can type a 
number which represents that many minutes ahead in the future or you type an 
actual date and time.  If you were to type a 5, then the Timed Event would be created 
to execute 5 minutes in the future from the time that macro line was executed.  If you 
wish to type a specific time and date, use a format of: yyyy-mm-dd hh:mm:ss.  This 
will create a Timed Event for that specific date and time. 

 
6. The Jump command is actually more of an intermediate command rather than a 

beginner’s command.  What the Jump command does is simply jump forward or 
backwards a specified number of lines.  You can think of the current line as line 0.  
The next line would be line 1, the one after that would be line 2 and so on.  The line 
previous to the current line would be line – 1 and before that would be line – 2.  A 
macro normally starts its execution at the first line and then proceeds to the next line 
and the next.  The Jump command allows you to change this “flow” of execution.  If 
you jump to a line before the first line, you’ll be taken to the first line.  If you jump to a 
line after the last line, the macro will terminate.  Be careful with the jump command!  
If you had a jump command with a ‘SKTTSDF’ value of 0, the macro would jump to 
the current line forever and would essentially be locked up.  Now you may be thinking 
what good is the jump command?  By itself, it’s not very useful except to maybe jump 
to the very end of a macro in order to end it early.  But when you become more 
advanced, you will be creating formulas and the real power of the jump command will 
become apparent. 

 
7. The Delay command allows you to pause the execution of a macro for a specified 

number of milliseconds.  When a macro is “delayed”, other macros can’t run.  In fact, 
all other command processing is essentially halted since PowerHome is designed to 
thread commands so that only one at a time is running.  The delay command is most 
useful for very short delays usually associated with the sending if IR commands.  All 
IR commands have a built in delay (default of 200ms) so they don’t run together and 
confuse the equipment.  But sometimes you may need a little bit more in order to wait 
for a piece of equipment to finish its processing.  Keep delays short and you 
shouldn’t have any problems.  Remember that there are 1000 milliseconds in a 
second. 
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8. The Wait command is similar to the Delay command in that the macro is paused, but 

the similarity ends there.  Wait commands are in seconds instead of milliseconds.  
Wait commands also don’t delay other macros or commands from executing.  When 
a macro is waiting, a snapshot of everything associated with the macro is saved to 
the database and a timer is started similar to a timed event.  The macro is then 
terminated.  Since PowerHome only allows a single process to be running at a time, 
other processes are now free to run.  You can see any “Waiting” macros in the 
PowerHome Status screen.  When the time is expired, the macro is reloaded and 
execution resumes where it left off.  The Wait command is useful when you want an 
action to continue at a later time (usually much later than with a delay) and you don’t 
want other execution to stop.  Consider the scenario where you turn a light on and 
you want it to automatically turn off 30 minutes later.  You could do this with two 
macros.  The first one turns the light on and the second one turns the light off.  When 
you call the first macro that turns the light on, the last line would be a Create Timed 
Event command for the second macro to turn the light off 30 minutes later.  With the 
Wait command, this could all be accomplished in a single macro.  The first couple of 
lines turn the light on, the next line is a wait command for 30 minutes (1800 seconds) 
and then the next couple of lines turn the light off. 

 
9. The Insteon command will send direct Insteon commands to an Insteon controller 

you have previously configured PowerHome to use.   See section 3.7 for an example. 
 

 

 
5.3 How Do I Tell PowerHome My Location? 
 

Much automation activity centers on sunrise, sunset, dawn and dusk.  You may want to turn 
on your outside lights 15 minutes before sunset and turn them off several hours before dawn.  
To calculate the correct times to perform these actions, PowerHome has to know where you 
are located. 
 
From the PowerHome Explorer screen go to PowerHome>Setup>Sun.  On this screen, 
you can set your location for the sunrise, sunset, dawn, and dusk functions.  You can select 
your state and city or enter your latitude and longitude directly.  If you select your state and 
city from the dropdowns, the latitude, longitude, and hours past GMT (Greenwich Mean Time) 
will be automatically populated for you.  You should also select whether you observe daylight 
savings time at your location. 
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(Figure 5.3 Sun Setup) 

 
 

5.4 How Do I Setup My X-10 Stuff? 
 

You’ve already setup an Insteon Controller in PowerHome (see Section 3.3).  That Insteon 
Controller is also an X-10 controller and you need not do anything more regarding setting it 
up as an X-10 controller.  If you do not have any other X-10 controller skip to section 5.4.2. 
 

5.4.1  Setting Up Your X-10 Controller 
 
If you have other X-10 controllers you have to let PowerHome know about them.  
 

1. Go to PowerHome>Setup>Controllers and then follow the instructions in Section 
3.3 only this time pick the name of the X-10 controller you have from the ‘Controller 
Type’ dropdown box. 

 
2. Click on the ‘Settings’ button.  You can check or uncheck the individual X-10 

commands that the controller will listen for.  You can send any X-10 command which 
is supported by your particular controller, but you’ll only want one controller to 
respond to incoming X-10 commands if you have multiple controllers.  If you only 
have a single X-10 controller, then you’ll typically have all the commands checked.  
Also, if you have a powerline controller and an RF controller, they can both receive 
the same commands since one will listen on the powerline and the other will be 
listening for RF. 
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(Figure 5.4.1  X-10 Controller) 

 
 

5.4.2  Setting Up Your X-10 Devices 
 
 
1. Much like setting up an Insteon device (see section 3.4) you setup an X-10 device by 

opening PowerHome>Devices>X-10>Units from the PowerHome Explorer, and 
entering the appropriate information for each of your X-10 devices. 
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(Figure 5.4.2 X-10 Devices) 

 
2. Initially, the X-10 Devices screen will have a single blank line.  To add additional X-10 

devices, right-click in the detail pane and select ‘Insert’ on the popup menu.  This will 
insert a new blank row.   

 
3. Enter an ID and Description of your choosing.  Enter the House Code and Unit Code 

from the dropdown boxes.   
 

4. Enter the Module Type and Controller from the dropdown boxes.   
 

5. Lastly, enter a Location for the device.  The last three columns can be left at their default 
values. 

 
 Be sure to save the newly added devices by pressing F5 
 
You’re now ready to use the X-10 devices in macros and formulas..  Your X-10 devices will 
also now appear on the PowerHome Device Status screen.  In addition, you can also 
control them through the virtual Palm Pad screen 
 
 

5.5 How Do I Setup My IR Stuff? 
 
 

PowerHome supports many different IR controllers including CIR, Multi-CIR, RedRat2, 
RedRat3, CPU-XA/Ocelot, Slink-e, USB-UIRT, and Global Cache.  PowerHome also 
supports multiple IR zones. 
 

5.5.1  Setting Up Your IR Controller 
 
 
Just as you have previously let PowerHome know about your Insteon controller, and your X-
10 controller, you must let PowerHome know that you have an IR controller connected to 
PowerHome through your PC.  
 

1. Go to PowerHome>Setup>Controllers and enter an ID name of your choosing and 
the controller type.  In Figure 5.5.1 note that a USB-UIRT IR controller has been 
entered. 

 
2. Click ‘Settings’ and make sure ‘Enable Remote Control’ is checked. (see Figure 

5.5.1).  This particular field is unique to the USB-Uirt and allows the USB-Uirt to 
respond to incoming IR commands instead of just sending them. You can leave the 
rest of the settings at their defaults. 
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(Figure 5.5.1  IR Controller Settings) 

 
 

5.5.2  Setting Up Your IR Devices 
 

If you have already set up an Insteon or X-10 device you are familiar with the first part of a 
two step process to set up an IR device.  
 

1. Open PowerHome>Devices>IR from the PowerHome Explorer,and enter the 
appropriate information for one IR device (for example, your tv, or home theater 
receiver).  .  Right-click and select ‘Insert’ to create a new row in IR Equipment 
screen. (see Figure 5.5.2) 
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(Figure 5.5.2 IR Equipment) 

  
 

2. Type a unique IR equipment ID in the ‘ID’ field.  Within this screen, the ID must be 
unique.  The ID should be descriptive of the piece of infrared equipment but short 
enough to save typing in later sections.  After entering an ID, next enter the 
‘Manufacturer’ of the equipment and then enter the ‘Model’ number. 

 
3. Enter the total number of keys you would like to learn for this piece of IR equipment.  

This would typically be the number of keys on the equipment’s IR remote, but may 
need to be adjusted up or down in certain circumstances.  When you enter the 
number of keys and go to the ‘IR Equipment Details’ screen (which you will do in 
the next step), PowerHome will automatically insert that number of rows for you.  You 
will not be able to insert or delete rows from the ‘IR Equipment Details’ screen and 
the number of rows can only be adjusted by the ‘Total Keys’ field.  When adjusting 
this number, if you increase the number, rows will be added to the end.  If you 
decrease this number, rows will be deleted from the end.  Once deleted, the data 
associated with these rows is lost and would have to be relearned. 

 
4. Next set the ‘Controller’ to the name of the controller you created in section 5.5.1.  

Leave the ‘IR Zone’ field set to ‘1’.  Certain IR controllers such as the CPU-
XA/Ocelot and Multi-CIR support more than one IR zone.  Most people will only have 
a single zone.  If you have more than one zone and would like to set the IR 
equipment to a zone other than ‘1’, refer to the notes for your controller in the User 
Manual Appendices for properly setting this value. 
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5. Leave the Learn Freq at ‘38’.  Most IR controllers do not use this value.  If you have a 
CPU-XA/Ocelot, then the default value of 38 is a good starting point. 

 
6. The next step in defining your IR equipment is to give details on the individual IR 

commands to PowerHome..  To get to the ‘IR Equipment Details’ screen, left-click 
the small button in the first column next to the IR Equipment ID you’ve just created.  

 

 

(Figure 5.5.3 IR Equipment Details) 

 
 

7. In the ‘IR Equipment Details’ screen, you should see a row for each key you 
declared in the ‘Total Keys’ field.  The Keys will be numbered starting at ‘10’ with 
each line incrementing by ‘10’.  This is done to make rearranging rows a little easier.  
When the rows are actually saved to the database, their ‘Key #’ will be divided by 10. 

 
8. Enter a description for each IR command you would like to learn.  The only other field 

to be concerned with at this time is the ‘Code’ field.  
 

9. After entering descriptions for each IR command, the next step is to learn the IR 
codes from your equipment’s remote.  All of PowerHome’s supported IR controllers 
store the raw code in the ‘Code’ field except for the CPU-XA/Ocelot.  This controller 
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stores the actual commands within the controller itself.  Detailed instruction to 
properly set up the CPU-XA/Ocelot with PowerHome can be found in the 
PowerHome Users Manual 

 
10. To learn your IR commands, right click on a single line and select ‘Record’ from the 

popup menu.  Follow the instructions onscreen and PowerHome will learn the IR 
code for that one line.  This is useful if you have to adjust an IR command that was 
not learned properly or you’ve just added an extra key.  If you have just setup the IR 
equipment and need to learn all the IR commands, choose the ‘Auto Learn’ option 
from the popup menu.  This will prompt you to learn all of the IR commands 
sequentially and quickly. 

 
11. Once you’ve learned your IR commands, save your settings by pressing the Refresh 

key (F5).  You may then right-click an individual command and select ‘Play’ from the 
popup menu.  Verify that the IR equipment is properly controlled. 
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5.7 The Control Center 
 
 
The Control Center is a simple yet sophisticated graphical user interface for controlling 
PowerHome.  The screens you create in the Control Center’s ‘Design View’ can be viewed from 
a PC, touch screen, mobile phone, PDA or on the web.    
 
From the examples in the beginning of this QuickStart Guide you’ve seen many ways to control 
various devices using PowerHome.  The Control Center is yet another way.  With its buttons and 
graphics you can design a group of user friendly screens to control PowerHome.  While you can 
use PowerHome without ever using the Control Center, you’ll quickly find that the Control Center 
adds great value by allowing you and others in your home to easily and quickly control the 
automation devices in your home.  A complete description of the Control Center can be found in 
the PowerHome Users Manual.  An example of a simple Control Center screen and a 
sophisticated Control Center screen can be found below. 
 

 

(Figure 5.7-1 Simple Control Center Example) 
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(Figure 5.7-2 Sophisticated Control Center Example) 

 
 

5.8 Where can I find some sample code? 
 
PowerHome is distributed with a sample database file called phsample.db.  It is installed in the 
database directory which would be “C:\Program Files\PowerHome\Database” if you installed 
PowerHome in the default directory. 
 
You can view this database file using the PowerHome Explorer.  Open the Explorer and press the 
second to last toolbar button on the far right or press F7.  This will bring up a dialog box that will 
allow you to select the sample database.  You can always see what database the current 
Explorer window is connected to in the Title of the Explorer window. 
 
Once connected to the sample database, you may view its macros, triggers, etc. and even export 
samples that can then be imported into your actual database. 
Sample Code is also available on the PowerHome Forums at http://www.power-
home.com/forum/default.asp.  
 
 
 
 

http://www.power-home.com/forum/default.asp
http://www.power-home.com/forum/default.asp
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Appendix A - An Insteon Primer 

 
A.1 Insteon Background  
 
To fully realize the features and possibilities of Insteon, it helps to understand a little about how it 
works.  
Unlike X-10, each Insteon device comes preconfigured from the factory with a unique address. 
With X-10, you could individually address each device by choosing a housecode from A to P (16 
possible choices) and a unitcode from 1 to 16. This gave you a maximum of 256 possible unique 
devices. With Insteon, each device is preconfigured with a 3 byte address yielding a possible 
16777216 combinations. This 3 byte address is represented in hexadecimal format (the decimal 
numbers 0 thru 9 and the letters A thru F). You will typically see an Insteon address such as: 
01.2A.4C. Each two hexadecimal digits represent a single byte with each byte representation 
separated by a period. All Insteon devices will have a label showing what their unique address is. 
Dimmable Insteon devices will have an output level ranging from 0 to 255. A value of 0 would be 
fully dimmed or off and a value of 255 would be 100% bright. When you control an Insteon device 
locally, it will default to turning full on. You can optionally set a "local level" so that when you turn 
a dimmable Insteon device on locally, it will turn on at a predefined level of your choosing. Once 
on at this level, if you press the "On" switch again, the light will go to "full on". If you set the "local 
level" to 0, the light will turn on to the last level the light was at when it was turned off. 
Additionally, each dimmable Insteon device has an individual "local ramprate". The local ramprate 
controls how quickly the device turns On or Off when the device is locally switched. Values for the 
ramprate range from 0 to 31 with 31 being nearly instant and 0 taking close to 9 minutes. 
All Insteon devices are inherently two-way unlike X-10 where typically only the more expensive 
devices were capable of two-way communication. Most Insteon devices are capable of being 
remotely controlled as well as acting as a controller to control other Insteon devices. 
The Insteon specification allows for a number of standard and extended length messages, but for 
our purposes, we really only need to concern ourselves with two types of standard messages. 
These are direct commands and group commands. A direct command is a single Insteon device 
directly communicating with another single Insteon device. These communications are typically 
acknowledged through two-way communication between the devices and automatically retried in 
the event of communication failure. The second type of message is a group message. Group 
messages are not acknowledged and are a broadcast command. In other words, the message is 
not sent to a single device. The message originates with a single device and is "broadcast" to any 
device within range. 
When an Insteon device controls another Insteon device, this is accomplished through group 
commands. A standard SwitchLinc dimmer has a single on/off paddle. As such, a SwitchLinc 
dimmer is capable of controlling a single group of devices. Multiple devices may be contained 
within a single group. When a SwitchLinc dimmer is turned on locally by pressing the "On" 
paddle, the dimmer turns itself on to the "local level" using the "local ramprate". It also sends out 
a group command if it has been "linked" to any other Insteon devices. This group command will 
be for group 1 of the SwitchLinc's address. Any device linked to the SwitchLinc will turn on at the 
"group level" and "group ramprate". Without getting overly complicated and technical, in addition 
to the "local level" and "local ramprate", each device has a "group level" and "group ramprate" for 
each group/device combination that it belongs to. 
When the group broadcast command from the SwitchLinc is received by another Insteon device, 
that device will check its internal database and see wheither or not it is a member of the 
SwitchLinc's group 1. If it is, it will look up the "group level" and "group ramprate" associated with 
the SwitchLinc's address and group 1 and will turn on to that level using the ramprate. A similar 
thing happens when the SwitchLinc is switched off or dimmed or brightened locally at the switch. 
As part of the Insteon standard, after the group command is sent (not acknowledged), the 
controller will then scan it's internal database and will send a direct group cleanup command 
(acknowledged) to each device that is a member of its group to insure that the group command is 
carried out. It's important to remember that when a device is added to a group (this process is 
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called "linking"), not only is a record created in the database of the controlled device, but also a 
record is created in the database of the controlling device. This way, the controlled device knows 
who is controlling it and the controlling device knows who it is controlling. 
The process of creating groups is called "linking". Each Insteon device has its own "database" of 
devices it controls and devices that control it. This data is stored in EEPROM and is remembered 
even in the event of power failure. A standard use of linking is during the setup of 3 or multi-way 
switches. Unlike X-10 where a 3-way lighting circuit had a master controller and then a cheap 
"dummy" slave switch that is electrically linked to the master, Insteon accomplishes 3 and multi-
way circuits virtually. Essentially, a single Insteon switch (the master) is electrically connected to 
the light being controlled with any "slave" type switches being removed from the circuit with 
simple wiring changes. The "slave" switch is then wired into the house wiring, but with no load 
(light) connected and without a direct connection to the master. The slave switch is then "linked" 
to the master with an Insteon group. When the slave switch is turned on, a group command is 
sent to the master and the master switch then turns on. At this point, it is not required to do any 
more in order for the 3 way circuit to work. However, if you want the LED indicator light on the 
slave switch to reflect the status of the light when the light is switched using the master, you must 
"cross link" the slave to the master. Basically what is done is that the slave is linked to the master 
such that the slave controls the master (this is necessary just to get the 3 way switch to work) and 
additionally, the master is "cross linked" to the slave so that the master controls the slave. Even 
though the slave is not electrically tied to the light, it will still receive an "on" command when the 
master is switched on and its status LED will reflect that the master is "on". 
An important point to remember is that if an Insteon device does not control any other devices (no 
links exist in its database as a controller), when the device is switched locally, no Insteon 
message is generated from the switch. What this means is that the PLC and any program 
attached to it will be unaware that a transition occurred. As long as the switch is controlling at 
least one other device, a group message will be sent and the PLC and any program attached will 
know that the switch was turned on or off locally. 
If local switch sensing is desired and the switch does not control any other loads, you can still link 
the switch directly to the PLC. This will in effect create a record in the switch's database and a 
group command will be sent. Although the PLC will not respond to the command, it will receive 
the message and pass it on to any connected program. 
The PLC device itself can have its own groups and control them as well. The PLC device can 
have a total of 254 groups from 1 to 254. The PLC CANNOT trigger another device’s group. All 
Insteon messages are signed with the address of the originating device and the PLC is no 
different. If you have a KeyPadLinc that controls 5 lights in its group 3, then you cannot trigger 
that group directly from the PLC and would instead have to re-create the same group of 5 lights 
into a PLC group. 
Group 255 is an "All Units On" group. If the PLC or another Insteon device sends a command to 
group 255, then any device that is a member of ANY group from the controlling device will 
respond. This is how a ControLinc performs an "All Lights On" and "All Lights Off" commands. 

 

A.2 PowerHome and Insteon 
PowerHome supports both direct commands from the PLC to another Insteon device as well as 
group commands sent from the PLC. PowerHome should also accurately track all Insteon 
commands whether they originate from PowerHome or from any other Insteon device on the 
network and update the Device Status screen appropriately. 
PowerHome also supports the creation of links within the PLC and remote devices from within 
PowerHome. If you prefer to create links using the physical tap-tap method, PowerHome 
supports this as well and will automatically query remote devices for any changes within their 
database. 
Once a controller has been created and communications established with the Insteon Device 
Manager, you're ready to setup your Insteon network. The easiest way to do this is to use the 
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Insteon Explorer. This new window is totally dedicated to setting and maintaining your Insteon 
network. You can read about this screen in the PowerHome Users Manual. 
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TROUBLESHOOTING 
 

 Why do I Keep getting this Database Error in the 
PowerHome Explorer 
 
The window shown below is characteristic of this problem: 
 

 
 
The reason this window appears is because you’ve tried to save data to the database and have 
left a required field blank.  There’s a lot of confusing information in this screen, but if you just 
concentrate on the second paragraph, it tells you what is wrong.  In this particular instance, it 
says: Column ‘key_desc’ in table ‘macroheader’ cannot be NULL.  What we’ve done is left the 
description field blank in the Macros screen. 
 
At this point you can select ‘Cancel’ and attempt to fix the error, or select ‘OK’ and you’ll lose any 
changes that you were attempting to make. 
 
You may have more than one row in error, so if you get this message again after fixing a problem, 
read the second paragraph and correct it as well.  Eventually you’ll get to save. 
 

 
 
 
 


